D-FACTS Devices in PowerWorld Simulator

Mark Laufenberg

May 20, 2014
Power Flow Control Basics

• Power flow is not directly controllable - to change the way power flows in the system, we need to be able to change line impedance, voltage magnitude, or angle differences

• Benefits
  – Relieve overloaded lines
  – Reduce transmission losses
  – Maintain acceptable operating conditions
  – Improve stability
  – Improved utilization of existing system
Flexible AC Transmission Systems (FACTS) – IEEE Definitions

• Flexibility
  – ability to accommodate changes in the system or operating conditions without violating stability margins

• Flexible AC Transmission System
  – incorporates power electronics and other static controllers to enhance controllability and increase transfer capability

• FACTS Controller
  – provides control of one or more AC transmission system parameter

Active Impedance Injection

- **The Synchronous Voltage Source (SVS)**

  - Injects an AC voltage, \( V_{COMP} \)
  - Controls \( V_{COMP} \) with respect to \( I_{LINE} \)
  - Changes effective line impedance
  - Many FACTS devices use this concept

  - In practice, \( V_{COMP} \) is 90 degrees out of phase with the line current)
  - Otherwise you must have a real power source or sink!

\[
V_{\text{comp}} = I_{\text{Line}} Z = -jI_{\text{Line}} X_c \text{ or } jI_{\text{Line}} X_L
\]
D-FACTS Devices

Distributed FACTS Devices

- Capacitive or inductive
- Distributed Static Series Compensator (DSSC)
- Distributed Series Reactor (DSR) (inductive only)
- Synchronous Voltage Source
- Attach directly to lines
- Small and modular

Potential D-FACTS Applications

• An inventory of applications to understand the full impact of DSRs may include
  – Contingency response capability
  – Control of loop flows
  – Increased transmission asset utilization
  – Phase balancing
  – Increase margin to voltage collapse
  – Enhance transient stability response
  – Increase flexibility for renewable energy transfers
  – De-localize Locational Marginal Prices (LMPs)
  – Reduction or delay of new transmission investment
  – Reduced risk in Financial Transmission Rights (FTR)
PowerWorld D-FACTS Support

• Overview of Program Support
  – Case information displays
  – Onelines

• Power Flow Control
  – In the power flow solution
  – Contingency analysis
  – Optimal Power Flow (OPF) tools
  – Sensitivity analysis

• Special features
Basic Program Support

• Power system object “DFACTSObject”
  – Settings dialog
  – PWB file support
  – AUX file support

• Oneline display object “DisplayDFACTS”
  – Fully customizable formatting
  – AXD file support
  – Auto-insertion
  – PWD file support (version 18 only)

• Full case information display support for both
The D-FACTS Object

• A single object represents all the D-FACTS devices on a line
  – Attaches to a transmission line
  – All quantities are per-phase

• Operating characteristics
  – Typically 47 uH per module
  – Specify max compensation or total number of modules
  – Specify minimum and maximum line activation current
D-FACTS Operational Profile

- Below $I_0$, the D-FACTS devices are inactive.
- Above $I_{lim}$, the cumulative injection of the D-FACTS devices is at its maximum value.
Basic D-FACTS Support

- Open “B7_DFACTS_Demo”
- This case has already been set up with D-FACTS devices on three lines, all in “Limit” mode
D-FACTS Devices in Limit Mode

- Run the power flow simulation
- Increase the load at Bus 5 and watch D-FACTS devices become active
Editing or Inserting D-FACTS

Open D-FACTS settings directly by right clicking on a D-FACTS object and choosing “show dialog”

“Show Dialog” or “Insert” in D-FACTS tab in Model Explorer

“B7_DFACTS_Demo”
Editing or Inserting D-FACTS

From the transmission line dialog, click “D-FACTS Devices on the Line” to see the D-FACTS settings.
D-FACTS Dialog – Inputs

In “Limit” Mode

Available control modes

Input tab

Basic settings

Auto-configuration settings

Current operating point

“B7_DFACTS_Demo”
D-FACTS Dialog – Control Info

Control settings
Covered later

Current operating point

D-FACTS Profile

D-FACTS Devices on the Line
D-FACTS Case Information Displays

- On the “D-FACTS Devices” tab in the Model Explorer, click “Fields”
- These are all the supported D-FACTS fields
  – We’ll cover what these fields do
- Drag and drop to change which fields are displayed in the table
- Right click and choose to save as an AUX file
- Open to view sample D-FACTS aux file “B7_DFACTS_Demo_Aux.aux”
- Export data to Excel, edit values, and load in
D-FACTS Oneline Displays

- Use formatting to fully customize the appearance
- Display any D-FACTS field
- Save with AXD or PWD (version 18) file
- Display Explorer support
Oneline Auto Insertion of D-FACTS

• For the entire case

• For a single line or a group of selected lines
D-FACTS Oneline Example

• Reopen “B7_DFACTS_Demo”
• Select all D-FACTS oneline objects and delete them. Delete “Object(s) Only”!

• Click Onelines > Default Drawing...
• Open the Display D-FACTS page
• Customize the settings for the appearance of new D-FACTS objects
  – Change fill color and the text fields to display
• Then click Draw> Auto Insert> D-FACTS...
D-FACTS Oneline Example

- Changed fill color
- Added text fields
D-FACTS Oneline Example

112 MW
AGC ON
1
1.05 pu
63 MW
Limit
50 MW
773
44% Amps

212 AMP
Xinj 0.000

40 MW
20 Mvar
3
1.00 pu
49 MW
52 MW

150 MW
40 Mvar

80 MW
30 Mvar
4
1.00 pu
52 MW

84 MW
11 MW
5
1.02 pu
11 MW

150 MW
40 Mvar

254 AMP
Xinj 0.000

60% Amps

161
52 MW

58 MW
43% Amps

157 MW
AGC ON
2
1.04 pu
5 MW

386
65% Amps

200 MW
0 Mvar

28 MW
55 MW

103 MW
AGC ON

49 MW
24% Amps

49 MW
44% Amps

55 MW
32% Amps

28 MW
55 MW

5 MW
28 MW
• Three modes of operation
  – Limit – Xinj responds based on line current (called Respond in version 17)
  – Fixed – Hold Xinj at a fixed value which may be set externally or manually
  – Bypass – Out of service (Xinj = 0)
  – Regulate – Control Xinj to achieve line flow in specified range (version 18 only)

• Oscillation detection logic
  – If switching on and off during the power flow solution, turn off of control (set to “Fixed”)
Power Flow Support

- Simulation Solution Process: Three Nested Loops
  - MW Control Loop
    - Voltage Controller Loop
      - Inner Power Flow loop
    Traditionally called the Power Flow
  Voltage Control Loop
  MW Control Loop
  Generation Interchange Control

- PowerWorld Simulator implements the control of D-FACTS devices in the voltage control loop of the power flow solution
- Limit – Determine limited devices based on line current, adjust D-FACTS according to piecewise linear lookup function
- Regulate – Determine out of range flows, calculate sensitivities, adjust devices to bring back into range
- If the D-FACTS values are changed, an additional power flow inner loop is solved
New “Regulate” Mode

• Automatically determines D-FACTS settings within the power flow to achieve a certain line flow range

• Uses coordinated sensitivities

• Might require special handling when there are a large number of devices that cannot achieve their desired control range

• Open “B5RWind_DFACTSRegDemo.pwb”

• Initially, the D-FACTS object is in bypass mode
Power Flow Regulation Example

- Flow on line 6-3 is initially out of range

![Diagram of power flow regulation example]
Regulation Mode Example

- Open the D-FACTS Information Dialog
- Change the Mode of Operation to “Regulate line flow”
- Open the Control Info tab and set the regulation range

![Control settings](image.png)

- Control settings
- Regulation range

```
Regulation range
```

```
Control settings
```

```
Inputs  Control Info
```

```
<table>
<thead>
<tr>
<th>MW Regulation is</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Present MW Flow</td>
<td>61.826670</td>
</tr>
<tr>
<td>MW Error</td>
<td>1.826668</td>
</tr>
<tr>
<td>Regulation Minimum MW</td>
<td>58.99997</td>
</tr>
<tr>
<td>Regulation Maximum MW</td>
<td>60.00002</td>
</tr>
</tbody>
</table>
```
Regulation Mode Example

- Solve the power flow; flow is back in range

Wind Control Mode:
Boundary Power Factor
0.9983262
0.9997122
0.9997122
0.9997122

Regulation Mode Example

Bus 2
1.000 pu
200 MW
100 Mvar

Bus 3
1.014 pu
100 MW
50 Mvar

Bus 4
0.987 pu
1.014 pu
80 Mvar

Bus 5
0.96875 tap
400 MW
92 Mvar
AGC OFF
AVR ON

Bus 6
94
Regulate
Actual flow: 59.581 MW
257
Bus 1
1.000 pu
83 MW
5 Mvar

100 MW
0 Mvar

100 MW
200
100 Mvar

50 Mvar

MW
Mvar

Regulation Mode Example

- Open the system log to see what occurred
Contingency Analysis

• Use Custom Monitors during contingency runs to see which D-FACTS lines respond for each contingency
• Placing D-FACTS devices on lines with the worst contingency overload can significantly improve the results
• It is also possible to designate more advanced responses to occur during a contingency
  – Remedial action schemes (RAS)
  – Special protection systems (SPS)
Contingency Analysis Example

• Open "IEEE118Bus_CTG_Demo.pwb"

• Open the Contingency Analysis dialog and set options
  – Under the Options Tab > Limit Monitoring > Advanced Limit Monitoring, select “Do not report base case violations”
  – Open “Limit Monitoring Settings”
    • Check “Do not monitor radial lines and buses”

• Auto-insert all single-line or transformer contingencies

• Click “Start Run”

• View the results
Aggregate MVA Overload Metric

- Aggregate MVA Overload (AMWCO) can be calculated per line, per contingency, or for the entire system

<table>
<thead>
<tr>
<th>Element</th>
<th>Measure of</th>
<th>AMWCO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line or Transformer, i-j</td>
<td>Weakness</td>
<td>[ \sum_{c=1}^{N_{cont}} \text{abs}(P_{ij}^c - P_{jk}^{max}) ]</td>
</tr>
<tr>
<td>Contingency, c</td>
<td>Severity</td>
<td>[ \sum_{ij=1}^{N_{lines}} \text{abs}(P_{ij}^c - P_{jk}^{max}) ]</td>
</tr>
<tr>
<td>System</td>
<td>Insecurity</td>
<td>[ \sum_{ij=1}^{N_{lines}} \sum_{c=1}^{N_{cont}} \text{abs}(P_{ij}^c - P_{jk}^{max}) ]</td>
</tr>
</tbody>
</table>
Contingency Analysis Example

- Open the Results Tab > View Results by Element > Lines/Transformers
- Add Aggregate MVA Overload field
  - In the case information display, right click, choose Display/Column Options, select “Aggregate MVA Overload” from the Contingency Results folder, click “Add –> ”
  - Also add the Custom Integer field
- 56 violations, 1221.14 MVA aggregate overload for displayed lines
- Sort by Aggregate MVA Overload
- Number the most overloaded lines using the Custom Integer column
Contingency Analysis Example

- Most severe contingencies sorted by AMWCO

- Insert D-FACTS devices on these lines
  - Right click on each row, choose Show Dialog, then “D-FACTS Devices on the Line” to open the dialog
  - On D-FACTS dialog, check “Max Compensation,” “Set I0 as,” and “Set Ilim as” to auto-configure using defaults
  - Click “Save”
Contingency Analysis Example

- Dialog without D-FACTS
Contingency Analysis Example

- **Dialog with D-FACTS**

  ![Diagram showing D-FACTS Information Dialog with calculated values and options for auto-config boxes.

  - **What's available**: Calculated values include the number of modules per phase, total available X, and present value of X. These values are shown in the left pane of the dialog.
  - **What's currently being used**: The right pane displays a graph showing the D-FACTS profile with injected X (μH) versus line current magnitude (A). The graph illustrates the profile for a specific circuit.

  **Check auto-config boxes**: There are checkboxes for auto-configuring characteristic curve parameters, such as max compensation, set I0 as, and set Ilim as, which are options for manipulating the curve parameters to fit the needs of the analysis.
Setting up Custom Monitors

- Custom Monitors report the value of monitored fields during contingency analysis
  - One custom monitor per field
  - Can be specified by an *AUX file.
- We’ll monitor how many D-FACTS devices have responded and on which lines by tracking changes in the Xinj field
- Open the Custom Monitor dialog from the Model Explorer in the “Tools and Add Ons” > “Contingency Analysis” folder
Custom Monitor Dialog

- Set up to monitor D-FACTS Xinj
- Only report Xinj if it changes from the base case
Custom Monitor Dialog

- Set up another Custom Monitor to report the number of modules used.
- Only report if DSRs have changed.

New name
Monitor is for Branches
New field
Limit what to report
D-FACTS Custom Monitors

• Case Information Display with new Custom Monitors

• Open the Contingency Analysis Dialog and run with the D-FACTS and Custom Monitors inserted
Results with D-FACTS

- System AMCO decreased from 1221.14 to 1081.1
- Violations decreased from 56 to 49

<table>
<thead>
<tr>
<th>From Number</th>
<th>From Name</th>
<th>To Number</th>
<th>To Name</th>
<th>Circuit</th>
<th>Xfrmr</th>
<th>Violations</th>
<th>Cust Int 1</th>
<th>Aggr MVA Overload</th>
<th>Max % Loading Cont.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>65 65</td>
<td>68 68</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>365.0</td>
</tr>
<tr>
<td>2</td>
<td>23 23</td>
<td>32 32</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>10</td>
<td>2</td>
<td>2</td>
<td>235.9</td>
</tr>
<tr>
<td>3</td>
<td>5 5</td>
<td>6 6</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>7</td>
<td>5</td>
<td>4</td>
<td>44.7</td>
</tr>
<tr>
<td>4</td>
<td>16 16</td>
<td>17 17</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>43.9</td>
</tr>
<tr>
<td>5</td>
<td>68 68</td>
<td>81 81</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>4</td>
<td>3</td>
<td>3</td>
<td>35.7</td>
</tr>
<tr>
<td>6</td>
<td>17 17</td>
<td>18 18</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>3</td>
<td>6</td>
<td>6</td>
<td>32.1</td>
</tr>
<tr>
<td>7</td>
<td>14 14</td>
<td>15 15</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>30.4</td>
</tr>
<tr>
<td>8</td>
<td>100 100</td>
<td>106 106</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>24.4</td>
</tr>
<tr>
<td>9</td>
<td>85 85</td>
<td>89 89</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>79 79</td>
<td>80 80</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>21.4</td>
</tr>
<tr>
<td>11</td>
<td>23 23</td>
<td>24 24</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>12 12</td>
<td>16 16</td>
<td></td>
<td>1</td>
<td>NO</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
### Viewing Custom Monitor Results

- **Results by Contingency**

![Custom Monitor Results](image)

**Custom Monitor**

- Results are recorded as special "violations"

**Custom Monitor Violation Info**

<table>
<thead>
<tr>
<th>Category</th>
<th>Element</th>
<th>Value</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Branch MVA 24 (24) -&gt; 23 (23)</td>
<td>110.69</td>
<td>100.0</td>
</tr>
<tr>
<td>2</td>
<td>Branch MVA 23 (23) -&gt; 32 (32)</td>
<td>132.52</td>
<td>100.0</td>
</tr>
<tr>
<td>3</td>
<td>Branch MVA 69 (69) -&gt; 47 (47)</td>
<td>196.86</td>
<td>100.0</td>
</tr>
<tr>
<td>4</td>
<td>Branch MVA 68 (68) -&gt; 65 (65)</td>
<td>282.53</td>
<td>100.0</td>
</tr>
<tr>
<td>5</td>
<td>Branch MVA 69 (69) -&gt; 47 (47)</td>
<td>196.86</td>
<td>100.0</td>
</tr>
<tr>
<td>6</td>
<td>D-FACTS Modules Line 5 (5) TO 6 (6) CTK 1 ActualNModules</td>
<td>84.00</td>
<td>0.0</td>
</tr>
<tr>
<td>7</td>
<td>D-FACTS Modules Line 5 (5) TO 11 (11) CTK 1 ActualNModules</td>
<td>36.00</td>
<td>0.0</td>
</tr>
</tbody>
</table>
Viewing Custom Monitor Results

- Custom Monitors Results Tab

Contingencies that caused "violations" for each monitor
Contingency Violation Matrices

- “Combined Tables” shows other results tables
Contingency Violation Matrices

View results by contingency or by Custom Monitor

By contingency

<table>
<thead>
<tr>
<th>Contingency</th>
<th>D-FACTS Modules Use Branch</th>
<th>D-FACTS Modules Used</th>
<th>D-FACTS Modules Used</th>
<th>D-FACTS Modules Used</th>
<th>D-FACTS Modules Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>84.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

By Custom Monitor

<table>
<thead>
<tr>
<th>Custom Monitor</th>
<th>D-FACTS Modules Used on Branch</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CustomMonitor &quot;D-FACTS Modules Used&quot; on Branch</td>
<td>84.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>84.00</td>
</tr>
</tbody>
</table>
Large Case Contingency

• Post-contingent response
Sensitivity Analysis

• How can D-FACTS devices help other lines?
  – Sensitivity analysis
  – Optimization

• Line impedance sensitivities
  – The first step towards a comprehensive power flow control solution
  – How does a change in line impedance affect the rest of the system?
  – What can be controlled by changing line impedances?
  – What D-FACTS settings will provide this control?
Line Impedance Sensitivities

\[
\begin{bmatrix}
\Delta \theta \\
\Delta V
\end{bmatrix}
= 
\begin{bmatrix}
\Phi
\end{bmatrix}
\begin{bmatrix}
\Delta x_{\ell}
\end{bmatrix}
\]

\[
\frac{dP_{\text{flow},\ell}}{dx_{\ell}} = 
\begin{bmatrix}
\frac{\partial P_{\text{flow},\ell}}{\partial s_{(\theta,V)}} & \frac{\partial s_{(\theta,V)}}{\partial x_{\ell}} & \frac{\partial P_{\text{flow},\ell}}{\partial x_{\ell}}
\end{bmatrix}
\]

\[
\Delta P_{\text{flow},\ell} = \begin{bmatrix}
\Delta \theta \\
\Delta V
\end{bmatrix} + \begin{bmatrix}
\Sigma
\end{bmatrix}
\begin{bmatrix}
\Delta \theta \\
\Delta V
\end{bmatrix}
+ \begin{bmatrix}
\Gamma
\end{bmatrix}
\begin{bmatrix}
\Delta x_{\ell}
\end{bmatrix}
\]

\[\Phi \triangleq \text{State to Impedance sensitivity matrix}\]

\[\Sigma \triangleq \text{Power Flow to State sensitivity matrix}\]

\[\Gamma \triangleq \text{Power Flow to Impedance sensitivity matrix}\]
Sensitivity Analysis Example

- Auto insert D-FACTS objects
- Use Select by Criteria to resize
Sensitivity Analysis Example

- Open the Sensitivity Analysis Dialog from Sensitivities > Flow and Voltage Sensitivities

Let’s look at the sensitivity of MW flows to this D-FACTS line (Branch 16 to 17)
Single Control Change

New control to calculate Xinj sensitivities for DSR placement
Multiple Control Change

- Filter branches to select as control devices only lines that have D-FACTS

- Toggle Selected field for ALL branches to “NO” first

<table>
<thead>
<tr>
<th>Selected?</th>
<th>From Number</th>
<th>To Number</th>
<th>Circuit</th>
<th>From Name_Nominal</th>
<th>To Name_Nominal</th>
<th>Circuit</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES</td>
<td>5</td>
<td>6</td>
<td>1</td>
<td>5_138</td>
<td>6_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>12</td>
<td>16</td>
<td>1</td>
<td>12_138</td>
<td>16_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>16</td>
<td>17</td>
<td>1</td>
<td>16_138</td>
<td>17_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>17</td>
<td>18</td>
<td>1</td>
<td>17_138</td>
<td>18_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>23</td>
<td>32</td>
<td>1</td>
<td>23_138</td>
<td>32_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>65</td>
<td>68</td>
<td>1</td>
<td>65_138</td>
<td>68_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>68</td>
<td>81</td>
<td>1</td>
<td>68_138</td>
<td>81_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>69</td>
<td>77</td>
<td>1</td>
<td>69_138</td>
<td>77_138</td>
<td>1</td>
</tr>
<tr>
<td>YES</td>
<td>100</td>
<td>104</td>
<td>1</td>
<td>100_138</td>
<td>104_138</td>
<td>1</td>
</tr>
</tbody>
</table>
Multiple Control Change
OPF Support

• Recently, PowerWorld added the ability to include D-FACTS as control variables in the optimal power flow (OPF) tools
  – Injected reactance X (Xinj) onto the line is the control
  – Device limits from the power flow settings are used

• OPF control allows...
  – D-FACTS to respond to overloads on lines throughout the system and reduce or eliminate the need to re-dispatch more expensive generation
  – Global coordination and control
  – Comparison of OPF control vs. stand-alone control

• OPF updates
  – Fixed a bug in OPF sensitivity calculation for D-FACTS
Primal LP OPF Solution Algorithm

• Simulator’s optimization tools are based on Linear Programming (LP)

• Solution iterates between
  – Solving a full AC power flow solution
    • Enforces real/reactive power balance at each bus
    • Enforces generator reactive limits
    • System controls are assumed fixed
    • Takes into account non-linearities
  – Solving a primal LP
    • Changes system controls to enforce linearized constraints while minimizing cost (or control change)
Optimal Power Flow (OPF)

• Inequality constraints
  – Transmission line/transformer/interface flow limits
  – Generator MW limits
  – Generator reactive power capability curves
  – Bus voltage magnitudes (not yet implemented in Simulator OPF)

• Available Controls
  – Generator MW outputs
  – Load MW demands
  – Phase shifters
  – Area Transactions
  – D-FACTS Devices
LP OPF Solution

• Cost model tells how to weight the control
  – For generators, this is a real cost and easy to understand
  – For all controls, a cost model is needed for the LP OPF

• Sensitivities tell how much effect each control has

• Combined cost and sensitivity in the LP tells how to get the most effect for the least cost
D-FACTS Sensitivities in LP

• LP basis matrix or tableau – sensitivity of each constraint to each basic variable

• Basic variables are not zero and not at a breakpoint in the cost function

• Tableau now includes the sensitivity of constraints (i.e., line MVA flows) to impedance x of DSR lines
**D-FACTS Cost Model**

- Cost functions are piecewise linear; at each iteration we are only looking at one piece.
- Limits are enforced using an extremely high penalty function outside physically viable range.
- Inside viable range, we model a slight incremental cost as the devices turn on.
- If Simulator’s OPF determines that it would cost more to enforce these limits, it will just “pay” this cost and overload the constraint.
OPF Solution Examples

• Open GSO_37Bus_DSRsOPF_basecase.pwb
• This case has an overloaded line and is set up to allow D-FACTS devices to be used as a control in the OPF
• Solve the OPF
• Alternatively, inserting D-FACTS on the overloaded line also relieves the overload
D-FACTS OPF Setup

Settings for D-FACTS OPF control must be enabled at three levels:

a) Case
b) Area
c) Line
Line LAUF69-HALE 69 is Overloaded

Pre-OPF
a) OPF without DSRs as Controls
## Example DSR Lines

<table>
<thead>
<tr>
<th>From Number</th>
<th>To Number</th>
<th>Circuit</th>
<th>X per Module (μH)</th>
<th>Auto Set I0</th>
<th>Auto Set Ilim</th>
<th>Auto Set Num Modules</th>
<th>I0 % of Rating</th>
<th>Ilim % of Rating</th>
<th>Max % of Line X</th>
<th>Num Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>18</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>67</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>18</td>
</tr>
<tr>
<td>15</td>
<td>24</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>32</td>
<td>29</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>175</td>
</tr>
<tr>
<td>29</td>
<td>41</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>374</td>
</tr>
<tr>
<td>30</td>
<td>32</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>39</td>
</tr>
<tr>
<td>30</td>
<td>41</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>118</td>
</tr>
<tr>
<td>39</td>
<td>40</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>207</td>
</tr>
<tr>
<td>48</td>
<td>54</td>
<td>1</td>
<td>47 YES</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
<td></td>
<td></td>
<td></td>
<td>22</td>
</tr>
</tbody>
</table>
b) OPF with DSR local control only
c) OPF with DSRs as Controls

System Cost
16334.45 $/h

Or…
OPF Results – LP Solution Details

Model Explorer: LP Details

OPF LP Solution Details

All LP Variables | LP Basic Variables | LP Basis Matrix | Inverse of LP Basis | Trace Solution

<table>
<thead>
<tr>
<th>ID</th>
<th>Org. Value</th>
<th>Value</th>
<th>Delta Value</th>
<th>BasicVar</th>
<th>NonBasicVar</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gen 14 #1 MW Control</td>
<td>10.000</td>
<td>10.000</td>
<td>0.000</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Gen 28 #1 MW Control</td>
<td>150.000</td>
<td>150.000</td>
<td>0.000</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Gen 28 #2 MW Control</td>
<td>150.000</td>
<td>150.000</td>
<td>0.000</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Gen 31 #1 MW Control</td>
<td>209.955</td>
<td>209.708</td>
<td>-0.247</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>Gen 48 #1 MW Control</td>
<td>16.000</td>
<td>16.000</td>
<td>0.000</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Gen 50 #1 MW Control</td>
<td>38.000</td>
<td>38.000</td>
<td>0.000</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>Gen 53 #1 MW Control</td>
<td>69.200</td>
<td>69.200</td>
<td>0.000</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>Gen 54 #1 MW Control</td>
<td>15.000</td>
<td>15.000</td>
<td>0.000</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>DFACTS Control Line from 12</td>
<td>0.000</td>
<td>0.025</td>
<td>0.025</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>DFACTS Control Line from 15</td>
<td>0.000</td>
<td>0.007</td>
<td>0.007</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>DFACTS Control Line from 32</td>
<td>0.000</td>
<td>0.016</td>
<td>0.016</td>
<td>12</td>
</tr>
<tr>
<td>12</td>
<td>DFACTS Control Line from 29</td>
<td>0.000</td>
<td>0.035</td>
<td>0.035</td>
<td>13</td>
</tr>
<tr>
<td>13</td>
<td>DFACTS Control Line from 30</td>
<td>0.000</td>
<td>0.004</td>
<td>0.004</td>
<td>14</td>
</tr>
<tr>
<td>14</td>
<td>DFACTS Control Line from 30</td>
<td>0.000</td>
<td>0.008</td>
<td>0.008</td>
<td>15</td>
</tr>
<tr>
<td>15</td>
<td>DFACTS Control Line from 39</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>16</td>
</tr>
<tr>
<td>16</td>
<td>DFACTS Control Line from 48</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>17</td>
</tr>
<tr>
<td>17</td>
<td>Slack-Area 1</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>4</td>
</tr>
<tr>
<td>18</td>
<td>Slack-Line 24 TO 44 CKT 1</td>
<td>-4.367</td>
<td>0.000</td>
<td>4.367</td>
<td>8</td>
</tr>
</tbody>
</table>
OPF Case Information Displays
Special Features and Applications
General Power Flow Control

• Idea: D-FACTS devices in the system can respond to help each other obtain certain control objectives
• Find and exploit comprehensive power flow control capability – “power routing”
• Purpose is to enable
  – Automated D-FACTS placement and setup
  – Strategies for global D-FACTS control
• Exploit the fact that not all locations have equal impact
Device Placement and Independently Controllable Line Flows

Complete decoupling

Complete coupling

\[
\begin{bmatrix}
P_{flow,1} \\
P_{flow,2} \\
P_{flow,3}
\end{bmatrix} =
\begin{bmatrix}
1 & 0 & 0 \\
0 & 2 & 0 \\
0 & 0 & 1
\end{bmatrix}
\]

\[
\begin{bmatrix}
P_{flow,1} \\
P_{flow,2} \\
P_{flow,3}
\end{bmatrix} =
\begin{bmatrix}
1 & 1 & 1 \\
2 & 2 & 2 \\
1 & 1 & 1
\end{bmatrix}
\]
 Placement Tool Overview

- Developing a new generalized tool to make these power flow control concepts a reality
- Towards a longer-term outlook of what we want from D-FACTS devices (and other distributed control devices)
- Use clustering and device placement dialog to determine how to set the D-FACTS devices to achieve a generic, user-specified control objective
- This tool is still being developed
  - Working on completing the tool, user interface, testing
  - Preliminary tool in version 18 beta only
  - More details, analysis, and examples to come
  - Let us know your feedback! What would be useful?
Placement Dialog

- Open new dialog
Select Input Data

- Select sensitivities
  - For DSRs, meter MW flows and choose Xinj as controls

- Save sensitivity matrix as clustering input
“Results by Object” Tab

- Shows input sensitivities and clustering results
Device Grouping and Placement

• Clustering is used to determine groups
  – Line flows that can be independently controlled
  – Line flows that are highly coupled
  – D-FACTS lines with similar impact
  – D-FACTS lines with capabilities that span the space

\[ \cos \theta_{v_1v_2} = \frac{v_1 \cdot v_2}{||v_1|| ||v_2||} \]

• User selects up to one prototype line per cluster to control since line flows within a group cannot be controlled independently

[*] Here, \( v_i \) denotes the row of the total sensitivity matrix of real power flows to reactive line impedance.
The line flows on the two overloaded lines are highly decoupled.

Thus, they can both be controlled independently with D-FACTS devices.

<table>
<thead>
<tr>
<th></th>
<th>(7,6)</th>
<th>(7,5)</th>
<th>(1,2)</th>
<th>(1,3)</th>
<th>(2,4)</th>
<th>(2,6)</th>
<th>(2,3)</th>
<th>(2,5)</th>
<th>(4,3)</th>
<th>(4,5)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(7,6)</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(7,5)</td>
<td>-1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(1,2)</td>
<td>-0.014</td>
<td>0.014</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(1,3)</td>
<td>0.014</td>
<td>-0.014</td>
<td>-1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(2,4)</td>
<td>-0.08</td>
<td>0.084</td>
<td>0.452</td>
<td>-0.45</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(2,6)</td>
<td>-1</td>
<td>1</td>
<td>0.0143</td>
<td>-0.014</td>
<td>0.083</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(2,3)</td>
<td>-0.077</td>
<td>0.076</td>
<td>0.59</td>
<td>-0.59</td>
<td>-0.19</td>
<td>0.076</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(2,5)</td>
<td>0.89</td>
<td>-0.886</td>
<td>0.14</td>
<td>-0.14</td>
<td>-0.19</td>
<td>-0.89</td>
<td>-0.12</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(4,3)</td>
<td>0.056</td>
<td>-0.056</td>
<td>0.63</td>
<td>-0.63</td>
<td>0.72</td>
<td>-0.056</td>
<td>-0.25</td>
<td>0.27</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>(4,5)</td>
<td>-0.183</td>
<td>0.18</td>
<td>-0.313</td>
<td>0.31</td>
<td>0.26</td>
<td>0.18</td>
<td>0.12</td>
<td>-0.62</td>
<td>-0.49</td>
<td>1</td>
</tr>
</tbody>
</table>
“Results by Cluster” Tab

- Each row corresponds to one cluster

- Refine parameters for placement and optimization
Target Control Objective

• Fields
  – Target Action – Raise, Lower, Don’t Care, or Maximize Control
  – Actual Value – The present value of the line flow
  – Target Value – The desired value of the line flow

• Inputs
  – Number of Controls – max number of D-FACTS lines to consider
  – Increment – Amount by which to change all of the target values

• Tool determines D-FACTS groups and placement from control objective
“Results by Attribute” Tab

- For displaying information for “attributes” or columns (i.e., the D-FACTS lines)

- “Actually Place Devices” inserts devices on the appropriate lines and sets Xinj values to achieve the control objective
Resulting Flows

- Newly inserted D-FACTS

- New line flows on targeted lines

<table>
<thead>
<tr>
<th>From Number</th>
<th>From Name</th>
<th>To Number</th>
<th>To Name</th>
<th>Circuit</th>
<th>Status</th>
<th>Xfmr</th>
<th>MW From</th>
<th>MW To</th>
<th>Xfmr (µH)</th>
<th>Num Modules Used</th>
<th>Xfmr (µH)</th>
<th>Num Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 One</td>
<td>2 Two</td>
<td>1</td>
<td>Fixed Xfmr</td>
<td>YES</td>
<td>YES</td>
<td>55.2492</td>
<td></td>
<td>30.00</td>
<td>193</td>
<td>907.109</td>
<td>193</td>
</tr>
<tr>
<td>2</td>
<td>2 Two</td>
<td>4 Four</td>
<td>4</td>
<td>Fixed Xfmr</td>
<td>YES</td>
<td>YES</td>
<td>55.2492</td>
<td></td>
<td>30.00</td>
<td>193</td>
<td>907.109</td>
<td>193</td>
</tr>
<tr>
<td>3</td>
<td>3 Three</td>
<td>4 Four</td>
<td>4</td>
<td>Fixed Xfmr</td>
<td>YES</td>
<td>YES</td>
<td>55.2492</td>
<td></td>
<td>30.00</td>
<td>193</td>
<td>907.109</td>
<td>193</td>
</tr>
<tr>
<td>4</td>
<td>4 Four</td>
<td>5 Five</td>
<td>5</td>
<td>Fixed Xfmr</td>
<td>YES</td>
<td>YES</td>
<td>55.2492</td>
<td></td>
<td>30.00</td>
<td>193</td>
<td>907.109</td>
<td>193</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Target Flow</th>
<th>Before Control</th>
<th>After Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-2</td>
<td>54.06 MW</td>
<td>55.25 MW</td>
</tr>
<tr>
<td>2-4</td>
<td>27.12 MW</td>
<td>27.34 MW</td>
</tr>
</tbody>
</table>